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STUDENT INFORMATION 
 
1.  Introduction 
 
This supplement presents the most current Operational Navigation (ONAV) route information available and 
includes detailed planning standards, chart-making checklists and Joint Mission Planning System (JMPS) 
instruction.  
 
2. Integrity 
 

• No sharing of JMPS files. 
• Do your own work. You shall create and print your own products. Crosschecking is encouraged – 

copying is not! 
• Dishonest or deceitful behavior will result in attrition. 

 
3.  Class Schedule 
 

• Day One 
o Academics: ONAV Flight Planning (MIL) 

  Corrections, Winds, and Chart Prep (MIL) 
JMPS Tutorial (MIL) 
Discuss Event Rehearsal 

o Homework: ONAV FTI, Chapter 1 -4 
 

• Day Two 
o Academics: JMPS Chart Prep/Mission Planning - ONAV 5 (Lab) 

JMPS Chart Prep/Mission Planning - ONAV 1 (Lab) 
o Homework: ONAV FTI, Chapter 5 - 6 

 
• Day Three 

o Academics Flight Procedures (MIL) 
o Homework Continue flight planning remaining ONAV routes (ONAV 2, 3,4, and MAX) 

Review ONAV FTI, Chapter 1 - 6 
 

• Day Four 
o Academics ONAV Exam Review (MIL) 
o Homework Continue flight planning remaining ONAV routes (ONAV 2, 3,4, and MAX) 

Review ONAV FTI, Chapter 1 – 6 / Prepare for Exam 
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• Day Five 
o Academics ONAV Exam  

ONAV Exam Remediation 
o Homework Chair-fly 
o Self-Study 

 
• Day Six  Rehearsal: Use ONAV Event Rehearsal script from Book Issue 

 
• Day Seven  Simulator: ON3101 (ONAV 5) 

 
• Day Eight  Simulator: ON3102 (ONAV 1) 

 
4. Notes  
 

• Day One:  Students shall bring UMFO Visual Navigation (VNAV) FTI (P-869) to class.  Students 
will login into NMCI via the JMPS laptops to ensure access to the network for mission planning on 
Day Two. 
 

• Day Two: Students shall bring “JMPS Planning Guide” and New Orleans Sectional to JMPS 
Planning Lab. 
 

• Additional Routes:  VT-10 maintains four additional ONAV Routes (i.e., “West 1”, “West 2”, 
“East 1”, and “East 2”).  If scheduled for one of these, students will sign-out the appropriate strip 
chart from the SDO at the VT-10 Duty Desk.  For fuel planning, students can find the corresponding 
JMPS Route files (e.g., “West1.jrt”) on the M:/ drive (M:/MasterTemplates/Additional Routes).   
Information for these routes (i.e., latitude/longitude, altitudes, etc.) is located on Page 20 of this 
guide. 
 

• Students can build their own strip chart books (5.5” x 5.5” manila booklets, bound at the top) or they 
can acquire blank strip chart books from Griffith Hall Book Issue. 
 

• Students SHALL bring ALL ONAV strip charts to EVERY brief for WX contingencies (all ONAV 
or MTR charts). 
 

• Students are not required to bring West 1 & 2 or East 1 & 2 unless scheduled for these routes. 
 

• If scheduled for East or West routes, students shall checkout corresponding strip charts from the SDO 
the day prior to the event when the schedule is published. 

 
• Students SHALL turn in ALL ONAV strip charts to the STAN office at the completion of the block 

checkride. 
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SIMULATOR EVENT INFORMATION 
 
This section provides guidance for the Operational Navigation (ONAV) simulator events.  Included are 
administrative notes, event profiles, and a checklist for completion of ground procedures during ONAV 
simulator events.  Bring the underlined items to each simulator event. 
 
Administrative 
 
• Students shall wear gloves; however, helmets, oxygen masks, G-suits, and harnesses are not required. 

 
• The NATOPS Pilot’s Pocket Checklist shall be readily available during the brief, flight, and debrief. 

 
• Bring applicable (IFR and VFR) Enroute charts, IAP booklets, a FIH and an IFR Supplement for each 

simulator event (as you would in the airplane). 
 

• Students shall bring a kneeboard with scratch pad and attached writing utensil to each simulator event. 
 

• Flight Plans:  Students shall prepare a DD-1801 for each simulator event IAW the ONAV academics, the 
ONAV FTI, and Chapter 4 of the General Planning publication.  Students shall provide a copy of the DD-
1801 for the instructor.  The “Event Profiles” section of this document contains the required flight plan 
information, including the destination and a qualifying alternate.   

 
• Jet Log: Students shall prepare a Jet Log IAW the ONAV academics, the ONAV FTI.  Students shall 

provide a copy of the Jet Log for the instructor.  Winds for the route will be “light and variable”; therefore, 
it is not necessary for the student to “wind” either the Jet Log or the ONAV chart. Based on the forecast 
weather data for each route, students shall calculate proper IMC or VMC divert fuels via FTI divert 
procedures.   
   

• ONAV Strip Chart:  Students shall prepare ONAV Strip Charts IAW the ONAV academics, the ONAV 
FTI, and the VT-10 T-6A Chart Standards provided in this document.  Forecast winds for both sim 
events will be “light and variable”; therefore, no pre-flight planning for winds is necessary.  
 

• Students shall bring a copy of AHAS Route Conditions for the day of the event (http://www.usahas.com/) 
 
• Gouge: The following items are gouge that is not permissible during any ONAV event. 
 

Calculators 
Tab Charts/Tables not part of the CTW-6 In-Flight Guide  
Anything on Enroute Charts other than scheduled Primary or Secondary route marked in a 
temporary way. 
Anything on Approach Plates other than NOTAMS or Calculated VDPs 

 
 
  

http://www.usahas.com/
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SIMULATOR EVENT PROFILES 
 
A.  Simulator Event #1 (ON3101).   
 

1. Profile:  Students will fly ONAV 5 under the following parameters: 
 

Departure: 
KNPA RWY 25L/R 

Altitude: 
10,000’ MSL 
 

TAS: 
IFR:    (KNPA to ONAV 5)  240TAS 
VFR:  (ONAV 5 to KMVC)  180TAS 

 
Route:    (DD-1801) 
               IFR:  KNPA   TEEZY   TRADR 
              VFR:  TRADR  [ONAV Points A through G] HOVEN 

Destination: 
KMVC 

 
Approaches:  Vectors RNAV(GPS) RWY 21 @ KMVC (Monroe County, AL) 
 
Weather:      Departure:    NAS Pensacola (KNPA)        26010  2SM BKN008 19/16 A2990 

Destination:   Monroe County (KMVC)          23010 10SM SCT020 19/16 A2990 
Alternate:      Mobile Downtown (KBFM)    30010 10SM SCT030 19/16 A2990 

 
2. Recommended ICPs: Time:  Description:   Distance: 

Between TP A and B:  3+10  Bridge    1.0 NM Left 
Between TP B and C:  8+40  Road/Power Line  0.5 NM Right 
Between TP C and D:  17+00  Road “Y”   0.5 NM Left 
Between TP D and E:  22+50  Road Bend   1.0 NM Left 
Between TP E and F:  28+20  Road/RR Intersection  0.5 NM Left 
Between TP F and G:  35+30  River Fork   0.5 NM Right 
 

3. Discuss Items: 
a. CTS for the block. 
b. Time and Course corrections. 
c. ONAV Turn Point Procedures. 
d. FACCU Process. 
e. 6-Minute Rule. 
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4. DD-1801 Flight Plan for ON3101 
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B.  Simulator Event #2 (ON3102).   

 
1.   Profile:  Students will fly ONAV 1 under the following parameters:  

 
Departure:   
KMVC RWY 21 

Altitude:   
VFR 

TAS:   
VFR:    180TAS 
IFR:      240TAS 

 
 
Route:    (DD-1801) 
VFR:  KMVC ONAV1 [Point A through G]   
 IFR:  [ONAV Point G]  BFM  TRADR TEEZY 

Destination:   
KNPA 

 
Approaches:  Vectors ILS Z RWY 7L @ KNPA  
 
Weather:      Departure:    Monroe County (MVC)          22010  3SM SCT040  19/17A2990 

Destination:  NAS Pensacola (KNPA)        05010  2SM BKN008 19/16 A2990 
Alternate:      Mobile Downtown (KBFM)    35010 10SM BKN020 19/16 A2990 

 
2.  Recommended ICPs:  Time:  Description:   Distance: 

Between TP A and B:  3+10   NW River Bend  1.5 NM Right 
Between TP B and C:  9+30  S End of 4R3   2.0 NM Left 
Between TP C and D:  17+00  Dam    2.0 NM Right 
Between TP D and E:  21+20  Road/River Bridge  1.0 NM Left 
Between TP E and F:  27+00  Road “Y’ (Uriah, AL)  1.5 NM Left  
Between TP F and G:  N/A  N/A    N/A 
 

3.  Discuss Items: 
a. Same Discuss items as ON3101. 
b. Terrain Clearance Tasks. 
c. Differences in IFR/VFR clearances 
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5. DD-1801 Flight Plan for ON3102 
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T-6A OPERATIONAL NAVIGATION ROUTES 
1.  ONAV 1 Route: 
 
Altitude  Point     Fac/Rad/DME Lat/Long 
 
As assigned to A-PWR PLT  SJI 040025  N3100.4   W8800.6 
2500’ MSL to  B-PWR PLT  GCV 062027  N3116.7   W8800.1 
2500’ MSL to  C-RD/RR BR  MVC 298021  N3138.8   W8742.1 
2500’ MSL to D-MICROWAVE TWR  MVC 345012  N3139.4   W8723.9 
2500’ MSL to E-SAWMILL  MVC 229004  N3125.4   W8724.7 
2500’ MSL to F-LAKE  MVC 221025  N3109.8   W8742.0 
2500’ MSL to G-RD INTX  BFM 032026  N3058.1   W8745.4 
 
2. ONAV 2 Route: 
 
Altitude Point     Fac/Rad/DME Lat/Long 
 
As assigned to A-WHITE WTR TWR 
      IN MCCULLOUGH   MVC 200020  N3110.0   W8731.6 
2000’ MSL to B-BLACK SILO    MVC 264006  N3127.4   W8727.8 
2000’ MSL to C-RR/DIRT ROAD INTX   MVC 004015  N3142.9   W8718.5 
2000’ MSL to D-TWR & GRAIN SILOS   MVC 068020  N3134.1   W8658.6 
2500’ MSL to E-TRAILER BY SMALL LAKE  MVC 093030  N3123.8   W8646.0 
2000’ MSL to F-FIVE GRAIN SILOS   CEW 347013  N3102.0   W8643.4 
 
3. ONAV 3 Route: 
 
Altitude Point     Fac/Rad/DME Lat/Long 
 
As assigned to A-RD/RVR BR    SJI 240016  N3036.7   W8838.5 
2500’ MSL to B-RD INTX    SJI 265029  N3043.8   W8855.0 
2500’ MSL to C-LAKE     GPT 327019  N3040.7   W8915.8 
2000’ MSL to D-RR/PL INTX    LBY 175025  N3100.0   W8920.5 
2000’ MSL to E-HOUSES ON LAKE   LBY 210009  N3117.7   W8926.1 
2000’ MSL to F-MIDDLE CHICKEN RANCH  LBY 065010  N3128.7   W8908.9 
2000’ MSL to G-CHURCH    LBY 074028  N3130.4   W8848.2 
 
4.  ONAV 4 Route: 
 
Altitude Point     Fac/Rad/DME Lat/Long 
 
As assigned to A–MON LOUIS BAY BRIDGE   BFM 191011     N3026.6   W8806.8 
2000’ MSL to B–HIGHWAY CPA   SJI 183016      N3028.4   W8824.2 
2000’ MSL to C–RD/RVR BR        SJI 275021      N3046.8   W8845.8 
2000’ MSL to D-RD/PL INTX    SJI 321014  N3055.5   W8830.9 
2000’ MSL to E-RD BR S. OF ESCATAWPA  GCV 019012  N3117.0   W8823.5 
2000’ MSL to F-BALLPARK    GCV 024025  N3127.6   W8815.2 
2000’ MSL to G-LAKE     MVC 221025  N3109.6   W8742.4 
2000’ MSL to H-RD INTX    BFM 032026  N3057.9   W8745.6 
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5.  ONAV 5 Route: 
 
Altitude Point Fac/Rad/DME Lat/Long 
 
As assigned to A-RR/PWR LN INTX  BFM 038024  N3054.7 W8744.3 
2000’ MSL to B-LAKE  SJI 041021  N3058.5   W8803.3 
2000’ MSL to C-RD/RVR BR  GCV 141008  N3059.2   W8824.2 
2500’ MSL to D-BLUE WTR TWR  GCV 033020  N3121.7   W8814.9 
2500’ MSL to E-RD/RVR BR  MVC 274030 N3131.4   W8756.1 
2000’ MSL to F-GRAIN ELEVATOR  MVC 294010  N3132.2   W8731.7 
2000’ MSL to G-MINE  MVC 319024  N3146.7   W8738.2 
 
6. ONAV MAX Route: 
 
Altitude Point Fac/Rad/DME Lat/Long 
 
As assigned to A-SAWMILL MVC 080022 N3129.8   W8655.7 
2000’ MSL to B-BRIDGE MVC 090045 N3124.0   W8628.8 
2000’ MSL to C-DAM MGM 172034 N3139.0   W8616.2 
2000’ MSL to D-RD BR OVER I-65 MGM 213023 N3154.6   W8635.3 
2100’ MSL to E-SOUTHERN LARGE WHITE 
     BLDG IN GEORGIANA MVC 067033 N3138.1   W8644.5 
2000’ MSL to F-555’ MICROWAVE TWR MVC 023019 N3144.4   W8711.2 
 

Abbreviations: 

BR Bridge 
CPA Closest Point of Approach 
HWY Highway 
INTX Intersection 
PL Power Line 
PWRPLT Power Plant 
RR Rail Road 
RD Road 
RVR River 
TWR Tower 
WTR Water 
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VT-10 T-6A ONAV CHART STANDARDS 
 
1.  Low- Level Route  

 
• Chart scale – TPC, Zoom to 130% 
• Turnpoint circles – Black, centered on the visual checkpoint  
• IP – square, Target – Triangle 
• Course line – Black   
• Route Corridor – Yellow. 4 nm either side of centerline for ONAVs. As required for MTRs. 
• Turnpoint/Time labels – White, with white background, C 11+35  
• Time ticks – 1 min apart, every 3rd labeled 
• Doghouses – 6 components, parallel to course line, located outside of route corridor 

 1.  Magnetic Course 
 2.  Leg Distance 
 3.  Leg Time 
 4.  Altitude (MSL) – per Planning Guide 
 5.  Mission Completion Fuel (MCF) – Write MCF in the margins above or below TPC 
 6.  Nearest Emergency Divert box – 3 letter ID, bearing, distance (example: 1R8 090015) 

• OCF (CHUM) – Blue, updated for current month 
 1.  Only CHUM can be drawn inside turnpoint circle 
 2.  Hazards within 500’ of altitude – Red circle, 1nm in diameter 
 3.  Manually write in any updates after the initial printing instead of reprinting the chart. 

•  Crossing Routes – Green arrow on the side it is coming from. Labelled with name (size 16). 
 1.  ONAVs – other ONAV routes 
 2.  Section Low Levels – any MTR that crosses route 

• Intermediate Checkpoints – Should have 1 per leg (not required on short leg (i.e. 4 min or less) 
1.  Handwritten on a margin of strip chart after printed out. 
2.  ICP’s also annotated on Jet Log (typed or handwritten).   
3.  Should include time and deviation from centerline.   
4.  ICP’s may be highlighted on strip charts. 

• Hazard fields inside route corridor – Yellow text box with black lettering (size 16). 
 Placed outside route corridor 
 Include airfield name, 3 Letter ID, and CTAF/Tower freq in box 

• Ensure filename (“Last Name ONAV#.jrt”) appears at the bottom of each page of strip chart. 
 
2.  Overview Chart 
 

• Scale – ONC, Zoom 100%.  Entire route should fit on one page, with everything legible  
• JMPS Overlays – Airports, Navaids, SUAS, Airspace Boundaries 
• The T-6 Overview Chart should include following:   

o ONAV route  
o Departure Airfield 
o 2 civilian diverts (denoted with a triangle) 
o 2 military diverts with gov’t/contract fuel (denoted with a square) 
o Destination Airfield 

• Emergency diverts along the route should include at a minimum: 
o The field’s three-character identifier (e.g., 4R3) 
o Tower or Common Traffic Advisory Frequency (CTAF) 
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3. Stripping the Chart (getting from JMPS to a route book) 
 

• Use glue stick (book issue or purchased) to affix strip chart to booklet. 
• Book should be 5-1/2” wide by 11” tall.  This gives enough room for the JMPS strip chart and a 

margin for leg notes.  The final product should fit on a kneeboard or under an approach strap. 
• Per the FTI, books are built from back to front (i.e. reverse order).  Last page will be the 

Overview chart.  Next will be from A to B; then, B to C, etc. 
  

• Front Cover:  Include the following: 
  1.  Name 

2.  Class Number 
3.  Route Name 

  4.  Copy of the ONAV Planning Guide or AP-1/B route description  
 

• Inside Pages:  In margins of each strip chart, post the following: 
1.  Wind T’s 
2.  Wind compensations – preflighted crab and airspeed  
3.  MCF 
4.  Intermediate Checkpoints (description, distance off course, ETA) 
 

• All writing neat and legible 
• Bring ALL route charts to the brief because of weather (i.e. all ONAV or all MTRs). 

o Students are not required to bring West 1 & 2 or East 1 & 2 unless scheduled for these routes. 
o If scheduled for East or West routes, students shall checkout corresponding strip charts from 

the SDO the day prior to the event when the schedule is published. 
• Have enough VFR Sectional or TPC coverage to navigate visually from the IFR cancellation point to 

the entry point. 
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Building a Chart in JMPS  
 
1.    Class Folder:  Class Leader creates a Class Folder on the “S:/StudentFolder” drive.  Each student then 

opens that Class Folder and creates a new folder with their last name only.  Within his or her folder, 
each student will create six folders, one for each ONAV route. 

 
2.   Load VT-10 preferences: 

a.  Browse to M:”\\Master Templates\VT-10 Preferences 
b.  Double click the VT-10 Preference file. (Black screen should pop-up and auto load preferences.) 

 
 3.   Open JMPS application 
 
 4.  Open a new route folder:   

a.   From the File Menu, select New 
b.   Select Route 
c.   Select T-6A and click on the “Create” button 

  d.   From the File menu, select Save As. 
e.   Browse to the appropriate folder– S:/StudentFolder/(Your class number)/(Your folder)/  
f.   Label the file “[Last Name]_ONAV X”. 
 

 5    Enter ONAV route data.  (Refer to the ONAV routes on page 8 and 9 of this Planning Guide.) 
  a.   Select Tabular View.  A spreadsheet will appear with one waypoint:  “KNPA/A”. 
  b.   Click on the field anywhere below the first line and a new blank line will appear. 
  c.   Label the waypoints 
   i. In the Fix/Point Box, enter the Turnpoint (TP) ID and its description. 
   ii. You must put a period (“.”) before entering the TP label (e.g., .A PWR PLT, .B SILO, etc.)  
  d.   Enter Lat/Longs for each TP. 

  e.   After entering the last Turnpoint, delete the original, preloaded waypoint: KNPA/A  
   (ONAV routes consist of only Point A through the target). 

  f.   Change Point Types for the IP (initial point) and the TGT (target) 
  g. Verify airspeed, bank angle, and altitude  
   i.    Airspeed: ONAVs – 180G 
   ii.   Bank Angle:  click on green ADI icon in the Bank block, select “No Turn”  
   iii. Altitudes:  Enter MSL altitudes for each leg. 
   iv. Double-check your entries. 
  h. Calculate your route using the calculator icon in the upper toolbar. 
   i. Compare results with another student. 
   ii. Do not continue if your route does not calculate properly!  
   iii. Common errors:   

 Are the Lat/Longs exact? Are they all North and West? 
 Other than the IP and TGT, do any of the other turnpoints have a type selected? 
 Speeds:  180G for LL route? 240T for the IFR enroute? 
 Select “No Turn” for the Bank angle?  
 Do you have the same winds aloft and LL route winds 
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6. Save your Route (.jrt) file (Save early and often) 
   
7.  Build and Print an ONC Overview Chart  
  a. Switch back to Graphical View  
 b. Change route line thickness.   

i. From the Overlay pulldown menu, scroll to Overlay Options and select your .jrt file 
  ii. Change Line Thickness from 3 to 6  
  iii. Change Symbol Size from 40 to 20  
  iv. Click on Apply 
  c. Click on the Overlay pulldown menu.  Select the following overlays:  
  i. Scale Bar  

ii. Airports 
iii Airspace Boundaries  
iv. NAVAIDs  
v. SUAS Boundaries  

 d. Open the Divert Drawing file  
i. From the File pulldown menu, select Open.  
ii. Select Drawing and click on OK.  
iii. Select M:\\Mastertemplates:\Master Divert.drx 

 e. Set up Overlay Layers  
  i. From the Overlay pulldown menu, scroll to Overlay Manager. 

ii. Use the controls to move the Scale Bar to the top, Master Divert.drx file second,  
    then the remaining overlays in any order. 

 f. Print an Overview Chart 
  i. Select Chart Tool icon 

ii. Recommend changing chart to the 1:2M scale (or zoom-out with CTRL + Mouse scroll) to           
view the entire route. 

  iii. On the side menu, click on the Single Page Layout Tool icon 
iv. Click anywhere in the middle of your route to drop a single, yellow print screen frame.   
v. On the side menu, click on the Select icon  

  vi. Select Portrait/Landscape as appropriate from Print Setup button on the side menu, 
       or by putting the cursor on the “handle” at the top of the yellow frame and rotating. 
  vii. (Optional) Brighten the chart.  Click on “bright” sun icon, or Ctrl <B>, four times. 

viii. From the side menu, select Print Preview; ensure the required items are in view:   
o Departure Airfield 
o 2 civilian diverts (denoted with a triangle) 
o 2 military diverts with gov’t/contract fuel (denoted with a square) 
o Destination Airfield 

  iv. Select Print  
  x. Remove the ONC Chart from Open Planning Data (Left Side): right click on the  
                .cht folder; select “Remove”;  then, Close (No need to save). If want to save, save as PDF. 
 
 
  8. Undo Things Specific to Overview Charts  
   a. Switch back to Graphical View  
  b. Click on the Overlay pulldown menu.  De-select the following overlays:  
  i. Scale Bar  

ii. Airports 
iii. NAVAIDs  
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 c. You should still have the following overlays open:   
i. Your Route (.jrt) folder,  
ii. Airspace Boundaries,  
iii. SUAS Boundaries,  
iv. Master Divert File (leaving open for Doghouse divert info.)  

 d. Change route line thickness.   
i. From the Overlay pulldown menu, scroll to Overlay Options and select your .jrt file 

  ii. Change Line Thickness from 6 back to 3.  
  iii. Change Symbol Size from 20 back to 40  
  iv. Click on Apply 
 
 
9.  (Optional) Setup JMPS to display Tab View and Graphical View simultaneously. 
 a. From the View pulldown menu, select Clone  

b. When prompted, clone the other view,  
i. If Graphical View is currently in view, clone the Tab View. 
ii. If Tab View is currently in view, clone the Graphical View 

 c. From the Window pulldown menu, select Tile Horizontally or Vertically. 
 
 
10. Determine Nearest Emergency Divert for Each Turnpoint 
 a. Switch to Graphical View. Center the screen on the turnpoint using Right click/Center Map. 

b. Use 1:500 TPC scale, Set Zoom - 100% 
 c. Click on the Analysis Tool.  Select Range and Bearing Tool from the side menu. 

d. Put the cursor on the turnpoint, click and hold. 
e. Drag the cursor to the nearest Emergency Divert and release mouse button 

 f. The Analysis Tool will deposit a red arrow on the chart with a bearing and distance 
g. Copy the divert airfield’s ICAO ID, bearing, and range (rounded to the nearest degree, NM). 

 h. Switch to Tabular View.  In the Desc box, enter the divert info for each Turnpoint. 
i. Enter the divert field’s 3-character ID, 3-digit bearing, 3-digit range FROM the turnpoint.  
ii. Example:  From TP “A” to Bay Minette: 022.2° for 12.8 nm.  Enter: 1R8022013. 

  iii. Hit enter after typing in the description. 
i. Right Click and Close (Do not save) the following overlays:  

Analysis Tool file (.jat file);  
Master Divert Drawing file (.drx file)  

 
 
11. Open Master Drawing Folder 

a. From the File Menu, select Open; then, select Drawing. 
b. Browse to and open M:/MasterTemplates/Master Drawing file . 

 c. IMPORTANT!  Immediately save this Master Drawing file as your file:  
i. From Open Planning Data (Left Side), highlight Master Drawing.drx 
ii. Right Click – Save As…  
iii. Browse to S: /Student/(Class number)/(Student folder)/ (ONAV X)/“ 
iv. Use the following format Last Name ONAV X”. Example:  JOYCE ONAV 5. 
v. Don’t type “.drx” extension as part of the label (it’s automatically attached) 

 d. Cut and paste from the provided drawings/textboxes. 
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12. Turnpoint/Time Labels  

a. Switch to Graphical View. 
b. Click on Drawing Editor.   
c. Turnpoint/Time Labels:  Copy a TP Time Label from the Drawing file and paste it outside of 

corridor, abeam the turnpoint.  Refer to the Tab View for the calculated elapsed times. 
 d. To edit these labels,  

i. Right click on the Time Label in question.  Select “Edit Properties”.   
ii. In the Text window, enter the appropriate elapsed time.  
iii. Set the “Angle” to the previous leg’s base heading. 

 
 
13.  Build Ellipses.  Use red and green ellipses to highlight following: 

a. Hazard Airfields:   
i. Any airfield within 5 nm of course centerline. 
ii. Cut & paste Red ellipse (0.7 nm radius) 

 b. Divert Airfields: 
  i. Any airfield outside on 5 nm that meets T-6A divert requirements. 

ii. Cut & paste Green ellipse (0.7 nm radius) 
.  c. Vertical Obstructions  

i. Any obstructions within 3 nm of centerline and 500’ of route altitude. 
ii. To help reduce workload searching for these hazards: use OCF and filter with VOD: 

• Click on the Overlay pulldown menu.  Select the following overlays:  
• Select OCF (blue icons showing latest obstacle IAW current CHUM) 
• Select VOD (red icons; set to filter out obstacles less than 1500’ AGL) 
• Overlapped OCF and VOD icons indicates an obstacle greater than 1500’ AGL 
• Cut & paste Red ellipse (1nm radius). 
• Turn off VOD overlays when finished. 

  d. Any other applicable AP1/B information, 
i. Noise Sensitive Areas (NSAs):  Cut & paste Red ellipse (3.0 nm radius) 
ii. No Fly Areas: Cut & paste Red ellipse (size as required) 

e. To edit these ellipses, right click and select “Edit Properties”.   
      f. Save All!  

 
 
14. Informational Text Boxes.  Use text boxes to provide critical information, such as comm info at 

hazardous airfields and emergency diverts, required MOA position reports, FSS calls, or for any other 
information/tasks required by AP1/B. 

a. Switch to Graphical View/ 
b. Click on Drawing Editor.   
c. Click on and drag a yellow text box outside of corridor near to item of interest 
d. To edit these boxes,  

i. Right click on the box in question.  Select “Edit Properties”.   
ii. In the Text window, enter the appropriate information.  
iii. Rotate by clicking on the box to highlight it; place cursor on blue box at top and rotate. 

 e. Save All!  
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15.  Crossing Routes.  Use green arrows to indicate conflicting ONAV routes.  We will use an overlay 
containing all the ONAV routes and place it over the current ONAV route to see potential conflicts. 
 a. (For ONAV flights) Open Master Crossing Routes  

  i. From the File Menu, select Open; then, select Drawing. 
ii. Browse to and open M:/MasterTemplates/Master Crossing Routes.drx file. 

b. Set up Overlay Layers.   Ensure your ONAV drawing file is on top of the overlay stack:  
  i. From the Overlay pulldown menu, scroll to Overlay Manager. 

ii. Use controls to highlight and move Master Crossing Routes.drx to the bottom stack.  
iii. Colors on your drawing overlay will be bright; the Crossing Route colors will subdued.  

c. Copy a green arrow from the Drawing objects and paste over the route centerline of the conflicting 
route leading to corridor of your ONAV route.  

d. Keep crossing route arrows outside of your ONAV route corridor.  
e. Only display the crossing route on the side of our corridor from which the crossing route is 

approaching and should capture the crossing route’s general vector.   
f. Another consideration:  while some routes don’t directly cross out flight path, out respective 4 NM 

corridors do.  This might be a good hazard to capture with a green arrow. 
g. To adjust the direction of the arrow after pasting, grab the tip or tail of the needle with the mouse 

and move it. Clicking on the center of the line will drop another point in the line. 
h. Label the crossing route by cutting & pasting a green background text box.   
i. To edit these boxes:  

i. Right click on the box in question.  Select “Edit Properties”.   
ii. In the Text window, enter the appropriate information.  
iii. Rotate by clicking on the box to highlight it; lace cursor on blue box at top and rotate. 

j. When complete, close the Master Crossing Routes.drx file. 
a. Right click on the file in the Open Planning Data (left side),  
b. Select Close.   

k. Save All! 
 

16. Generate Strip Charts  
 a. Zoom out or switch to JNC (1:2M), or zoom out (CTRL + Mouse scroll). 

b. Add one long extra route leg.  This step ensures JMPS will create enough strip charts to cover all 
of the desired legs.  (ex. Need 6 print screen boxes for ONAV5) 

  i. Select Route Editor.   
  ii. Click the last turnpoint (i.e., the Target) to highlight it 
  iii. From the side menu, click on the Add Turnpoint icon  
   iv. Some distance from the target, click on the chart to add one long leg  
 c. Select Chart Tool. Move the cursor to the Chart Tool menu on the right side.  
  i. Click on the Generate Strip Charts icon  

 ii. Click on the Snap to Route Leg icon 
 iii. Click on the Align to Route Leg icon  

 d. Delete Extra Route Leg(s) 
  i. Select the Route Editor  
  ii. Click on the extra turnpoint(s) and select Delete  

e. Move your Strip Charts. Place a blue strip chart box on each leg  
  i. Click and hold a blue box and move it near a leg of the route. 
  ii. The selected box will grab and align itself to the nearest leg 

  iii. Repeat for each leg  
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 f. Delete extra strip charts boxes, if necessary.  
  i. Right click on extra strip chart boxes and Delete  
 g. (Optional) Dim Map if you brightened it after making your Overview ONC 
  i. Click on “dark” sun icon or Ctrl <D> four times. 
 h. Add VOD NOW. 
    i. Click on the Overlay pulldown menu.  Select VOD.  
  i. Set up Overlay Layers  
  i. From the Overlay pulldown menu, scroll to Overlay Manager. 

ii. Use controls to highlight and move overlays in the following order  
    .cht file  
    .jrt file  
    .drx file  
    OCF  
    Airspace Boundaries  
    SUAS Boundaries  
 j. Print Preview your Strip Charts  
  i. Select Chart Tool  
  ii. Select Print Preview  

k. Review each leg and confirm the following: 
  i. There is a strip chart for each leg  

ii. One can read the Turnpoint/Time Labels, doghouses and text boxes.  
iii. Crossing routes are posted and labeled. 
iv. No drawing objects inside the corridor except for hazards. 
v. If able, one can see the doghouse for the next leg. 
vi. Each leg has some amount of chart displayed past the turnpoint.  

 l. Print Your Strip Charts  
  i. Select Print from the Print Preview Screen 
  ii. Go to Print Preferences and ensure “one sided print” only.  
  iii.  If necessary, browse to the Printer preferences and change orientation to Landscape. 
 m. Save your Chart Tool (.cht) file  

i. From Open Planning Data (Left Side), highlight Chart Tool1.cht 
ii. Right Click – Save As…  
iii. Browse to S:/Student/(Class number)/(Student folder)/ (ONAV X)/“ 
iv. Use the following format Last Name ONAV X”. Example:  JOYCE ONAV 5. 
v. Don’t type “.cht” extension as part of the label (it’s automatically attached) 

 n. Save All!  
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Creating a Jet log/Pilot Card 
 
Open the “.jrt” file for the route you are flying: 
- Open your ONAV # files (located on S:/Student/Class XX-XX/Last Name/ONAV #) 
- If assigned, WEST 1 or 2, or EAST 1 or 2, look in M:/MasterTemplates/Additional ONAV Routes 

 
1. Enter Route Specific Information 

a. Set JMPS to Tabular View. 
b. Insert all appropriate points for your route of flight.  

Example: KNPA-TEEZY-TRADR-<ONAV 5>-HOVEN-KMVC-KBFM (alternate)  
 c. Click on Type box for the departure airfield and select ST (Start Point). 

d. Select the row with your planned destination airfield: 
i. Select Leg Editor from the top menu.   
ii. Change the Command tab from Standard to Approach.   

e. Change airspeeds for your route of flight.  
Example: 240T (airspeed) to TEEZY and TRADR and to HOVEN and Alternate 

f. Change for your route of flight.  
Example:  10000M (altitude) to TEEZY and TRADR and to HOVEN and Alternate.  

 g. Set route clock to zero at route entry 
  i. Select the line for the first turnpoint (TP ‘A’) 
  ii. Click on the All Clock Times icon 
  iii. Select TPT Clock, 00:00:00, Apply, Exit 
 h. Click on Calculate icon. 

i. Sanity Check all information!  (Headings, distances, fuels, times, etc.) 
 
2. Preparing Pilot Card for your event.   
 a. Select “One-Click For Generation” Icon. 

b. Open Excel form (should appear on bottom bar after generated). 
 
3. Calculate Alternate Fuels. 

a.  Copy/Type (don’t cut & paste) the following information from the Route of Flight section of the 
Pilot Card to the Alternate line in the Divert and Bingo Fuels section:   

• Course  
• Altitude  
• Distance  
• ETE (round to nearest minute) 
• Leg Fuel (round up to the nearest 10 lbs). 

b. Type in the Divert airfield’s four-letter identifier. 
c. When this step is complete, highlight all rows in the Route of Flight section beneath the 

Destination line, right click and select “Clear Contents”.  Do not delete any rows. 
d. Calculate Alternate Fuel Total: 
    IMC Divert = Fuel to Divert (“Leg Fuel”) + 50# for Approach (if needed) + 125# on Deck 
  VMC Divert = Fuel to Divert (“Leg Fuel”) +120# on Deck OR 200#... Whichever is HIGHER 
e. Calculate and enter MCFs 

i. Determine spare fuel (EFR at Destination Airfield – Divert Fuel) 
ii. Enter spare fuel in the blank Spare Fuel cell at bottom right of spreadsheet 
iii. This macro automatically subtracts Spare fuel from EFR at each point, thus producing an 

MCF for each turnpoint  [MCF at Each Point = EFR at Each Point – Spare Fuel] 
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4. Calculate Bingo Fuel 
  a. Determine the Bingo Point, i.e., the farthest point on the ONAV route from the planned 
destination. Use the Analysis Tool, if necessary. 

  b. In JMPS Tabular View, add a line beneath the Bingo Point and enter the IAF for the planned 
destination.   

  c. Change the altitude for this new leg, airspeed to 240T, add winds aloft (if desired). 
  d. Click on Calculate icon 
  e. Copy/Type the Bingo information from the JMPS Tab View to the Bingo Fuels section:   

• Course  
• Altitude  
• Distance  
• ETE (round to the nearest minute) 
• Leg Fuel (round up to the nearest 10 lbs). 

  f. Type in the Bingo Turnpoint Identifier. 
  g. When this step is complete, delete the Bingo line in the Tab View and re-calculate. 
  h. Calculate Bingo Fuel Total 
   BINGO = Bingo leg Fuel (to the IAF) + 50# (IAF to Destination) + Divert Fuel 

  
5.  Complete remaining required information on the Pilot Card: 

a. Aircraft call sign 
b. SNFO:  enter rank and name 
c. LL Route:  enter the ONAV # 
d. FP Route:  enter the stereo flight plan or “DD 1801”,  
e. Winds: enter winds aloft for cruise and the route, e.g. High:  330/20 Low 290/15 
f. Print two copies. Give one to the instructor 

  g. Save excel file.  S:/Student/Class XX-XX/Last Name/ONAV #) 
 
6.  Add your intermediate checkpoints (ICPs typed or handwritten). 
 
7.  Copy MCF’s to your strip charts. 
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T-6A ADDITONAL ONAV ROUTES  
 

- VT-10 maintains four additional ONAV Routes: West 1, West 2, East 1, and East 2.   
- If scheduled, students will sign-out the strip chart from the VT-10 SDO.   
- For fuel planning, students can find the Route files for these routes (e.g., “West1.jrt”) on the M:/ 

drive (M:/MasterTemplates/Additional Routes).    
 
1. EAST ROUTE 1.  (Depart KNPA IFR: JAYDI INBRD CEW DEFUN...then to ONAV route entry) 
Altitude  Point    Fac/RAD/DME  Lat/Long 
As Assigned to A – RADOME  MAI 251050   N3033.9/W8555.3 
2000’ MSL to  B - CEMETERY  MAI 271029   N3047.8/W8541.4 
2000’ MSL to  C - WHITE BLDG  MAI 253008   N3044.9/W8516.1 
2000’ MSL to  D - HWY 90 BR  MAI 109016   N3042.1/W8451.5 
2000’ MSL to  E – RR BR   MAI 094031   N3054.9/W8434.9  
2000’ MSL to  F - SOLAR FARM  MAI 039030   N3110.3/W8445.8 
(IFR after ONAV route…SZW KTLH) 

2. EAST ROUTE 2. (Depart KTLH VFR to ONAV route entry) 
Altitude  Point    Fac/RAD/DME  Lat/Long 
As assigned to  A – 6 WATER TANKS  MAI 075025    N3054.3/W8435.6   
2500’ MSL to  B – HWY BR    MAI 027014   N3058.6/W8500.4 
2500’ MSL to  C – DRAG STRIP   MAI 337019   N3106.0/W8516.7 
2500’ MSL to  D – 5 WAY INTX   MAI 306018    N3057.0/W8524.1 
2500’ MSL to  E – LAKE    MAI 300035   N3103.7/W8540.2 
2500’ MSL to  F – HWY/I-10 INTX   MAI 266029   N3045.8/W8541.1   
(IFR after ONAV route... DEFUN CEW PENSI KNPA) 

3. WEST ROUTE 1 (Depart KNPA IFR- KNPA TEEZY TRADR PLEBE MINDO...then ONAV route 
entry) 
Altitude  Point    Fac/RAD/DME  Lat/Long 
As assigned to  A – I-12/RVR INTX  HMU 260014   N3028.5/W9040.4 
2000’ MSL to  B - RVR/PL INTX  RQR 316017   N3016.9/W9047.6 
2000’ MSL to  C – RVR ISLAND  LSU 155018   N3011.8/W9109.6 
2000’ MSL to  D – RVR Y   LFT 093025   N3010.8/W9131.7 
2000’ MSL to  E – I-10 BR   LFT 054017   N3020.6/W9143.1 
2000’ MSL to  F – RR INTX   LSU 280016   N3033.2/W9134.6 
(IFR after ONAV route…LFT KARA) 

4. WEST ROUTE 2 (Depart KARA VFR to ONAV route entry) 
Altitude  Point    Fac/RAD/DME  Lat/Long 
As assigned to  A – OBSERVATORY HMU 269019   N3033.8/W9046.5 
2000’ MSL to  B - RD/RVR INTX  HMU 346016   N3046.7/W9029.9 
2000’ MSL to  C – HORSE TRACK  HMU 049013   N3038.1/W9012.4 
2000’ MSL to  D – PAPER MILL  PCU 328015   N3046.5/W8951.8 
2500’ MSL to  E – RD INTX   MCB 122028   N3102.2/W8948.4 
2500’ MSL to  F – OIL TANKS  LBY 187024   N3102.1/W8927.0 
(IFR after ONAV route... WIGGO SJI JERYS TEEZY)  
 


